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3. EUA X DMA Xl (A3) . DMA £ X K/
(L) DLET—AM k% (DMA R 1 KEER.

BB 6: KHER LMLy A3 1) DMA ZZ1X . 7]
DMA ZZh XARIE T LA )5, AR EDDER 1.

INRAEEE T INAFRZR T —4 DMA il fFi G %
1 BARY) SRR BCHEAT HelE AL . A R T R
e Tk o BHem DAE — /N 8 3 Y EAT DD A 22 4R
FRIEIR PR FZ AR R A pe i o X, SR AP AN BE
AAEM RIS, AT AN BT, B 11 BoR T
AN B 7 HEAT IO B AL S LA S AT SR AE I P B B
By 0 MER T 1% DMA 2 X K15 ] 70 Al 1 20t
gk (BETA & MBS X, 8 DR
i ‘a’ ‘b’ BRI R . BEAR AT B IR AT #R A
AT LAHER DMA AT IR, JF o vF GPIF I K4
TRHESEAL S B P EAT A4S A o

B 11, A E AT e A R

0 DMA Descriptor 1
Buffer Address: Al — Size L
Next DMA Descriptor: 3
DMA Descriptor 2
Buffer Address: A2 — Size L
Next DMA Descriptor: 4
DMA Descriptor 3
Buffer Address: A3 — Size L
Next DMA Descriptor: 1
DMA Descriptor 4
Buffer Address: A4 — Size L
Next DMA Descriptor: 2
Al
DMA Buffer 1
Al+L
A2
DMA Buffer 2
A2+L
A3
DMA Buffer 3
A3+L
A4
DMA Buffer 4
Ad+L

SB 1. RIS EETN, BEY 0 EETY 1 25N
DMA H5iR 75 1 1 DMA #5R 7% 2.

BB 2. MEHIEN, BT 0 BEUELH3 DMA ZphX
1, ZERIEERN LAY . BRsHG, hefsip

3.

WWW.Cypress.com
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BB 3: GPIF I V)#: GPIF 288, Mindl#eit 47 B L
HEET. BT 1 TFEKREREETE DMA ZMHIX 2 ),
FIN &Y 0 ¥ % DMA {5 3. BT 1 52 iifEm
L MW EERN, BT 0 Ol IFE IR LHmE] DMA 42
HIX 3 W,

SB, 4: GPIF Il Wb PRI BIR 4G GPIF 2452, X,
BT 0 BKEN L EIEEHE DMA ZMX 3 . [F
W, BT 1K DMA R85 4, DB I AdE %
%) DMA ZE0b X 4 . BT 0 seifE s LA 70 S
G, SEBLIES,

BB 5. GPIFIEERT 1 MEHEEHE DMA (X 4
W. [N, ZE:5 0Nk DMA #R %% 1 D& IFG SR
% DMA Z2pPIX 1 . HER, S5 5a 558 1a M,
BERERZT 1 AT, 102 [ 4T 50 15 4
S8

S&| 6: GPIF Il HxUHEETR, BHF 0 48% LAFE
FTHWE LT DMA Zh X 1 . & UIB #2ii i 7 B
AT T DMA Zrh X F I pTE#dE. 82 1 R4
# DMA IR FF 2 a8 S &%) DMA 20X 2 1.
TR, TP 3.

RYEg R (USB) B8 JF B DMA Z2rR X (BLEzIR
GPIF Il I F— 4D i, GPIF II BT A4 RerE i
o WSO R AL, X DMA 223 X 1 5 1R
W AmE, FERETEREE.

WWW.Cypress.com
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fEH FX3 BE4THIIR USB 3.0 f£%

AT RIENA T L IHIB AT — M E R E R PR, WERT LT USB EHLYE FX3 4 BULK OUT 1 BULK IN £
i o

FEPATIZoRBIRT, TESEILU N

1. W% EZ-USB® FX3™ SuperSpeed Explorer £ (CYUSB3KIT-003) . 7EiZidF2d, FX3 &M USB FHL FEIM,
AR E FX3 DVK R M USB jash. EZHTEBRLSE (Wi 12 FR) , RikH USB Jazh. XLkl as ik B #R 6 H
— AN ERERFE B IR . BRZITFRRAIEMEE, ESFHEMH ) fa0 . SuperSpeed Explorer E 4 iR X 8
USB £edifitm (Egkfite) . REEEER FX3 JFREM (CYUSB3IKIT-001) , i&Hfiat C.1. 3kl EZ-USB FX3
DVK, VLT A REREhk 2% 5 B Ve s 8.

& 12. SuperSpeed Explorer &4 SR ) USB Jahit &

WWW.CYpress.com YRS 001-88777 iR A*A 11
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2. %% EZ-USB FX3 SDK., M#3Ki%#% Installation Type Wiff, #Fi&ZFEIAK Typical Wi,

273 FX3 SDK Ja, B ER5)

5 \F| Eclipse IDE T/EIX N (Eclipse IDE %% {FE N SDK f1—&84r) - BB FTA BRG] S AE IDE I, E#E T3

PR

a. M Start LTI Eclipse IDE. K%k All Programs > Cypress > Eclipse > EZ USB Suite. #ZEA M TIEX
SRS, HJET

s

S BEIN#R AT LAE SCH DI B4R

K] 13. A “Start” ZEFTH “Eclipse IDE”

1. Cypress

. ARM GCC
. Bridge Control Panel 1.7
. Cleck Programmer1.3
. Cypress Suite USB 3.4.7
. Cypress Update Manager
. Cypress USBSuite
. Eclipse
M EZ USE Suite Files

8 2 usB suite

EE‘ Release Motes
1. FX35DK
.. GPIFII Designer
.. PSeC Programmer 3.17
. UsE
i

m

b. XH¥ITIF—AEH “Eclipse IDE” , 7E “Project Explorer” Ui FIRAFMIIE . T — 5 5Bk 2838 h i ) 5
HS A% “Project Explorer” .

14. F AB{H Z i () Eclipse IDE

| & Resource - Cypress EZ USE Suit

Eile

=5

Edit Davigate Search Project CYTools Run Window Help
wiihd S R BA HFH ey 5 ([ Resource |
L Project Explorer £3 =g =g
EEIE
8= Outline 52 ] Task List| =g
An outline is not available.
| Tasks 12 PR
0items
Description Resource Path Location Type
‘ n v
0 items selected

Www.Ccypress.com
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c. fk¥iE#* File > Import.
d. 1Kiki%$E General > Existing Projects into Workspace, #&J& &7 Next.

e.

15. #4F “Existing Projects into Workspace”

B Import

=

Select
Create new projects from an archive file or directory.

Y

=

Select an import source:

type filter text

4 (= General
[T, Archive File
|12 Existing Projects into Workspace |
[, File System
=L Preferences

b= CGIC++

=

[ = Git

[ 2= Install

[ [~ Run/Debug
[+ = Tasks

[+ = Team

Mext = Finish

@ < Back

Cancel t

machines)\Cypress\EZ-USB FX3 SDK\firmware #% .

P 16. LEFEIR H %

-
| Import 8

Import Projects
Select a directory to search for existing Eclipse projects.

®) Select root directory: | |

() Select archive file:

Projects:

Select All
Deselect All

W% SDK Z 34 B [ 2F B 3. 555 Browse... 4440, 2R /5%; %] Cypress SDK firmware X3, xfF HL
Windows %3, % EJef7 T C:\Program Files (Program Files (x86 on 64-bit

Www.Ccypress.com
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f. AIEPTA SRR G H . s 1S R Select All 4% 8. [FIFE,

7 Finish #24k.

K 17. W5 SDK 223 i) “firmware” H 3¢

Browse For Folder

=

Select root directory of the projects to import

4 | Cypress
> | Bridge Control Panel
. Cypress Update Manager
4 || EZ-USE FX3 SDK
4012
> | application
> |1 arm-none-eabi
/ bin
> | configuration
. doc
> L0 driver

> features
4 firmware

> basic_examples

lom |

> | boot_fw
| commen
> dma_examples
. lpp_source -
Folder: firmware

Make Mew Folder QK

] [ Cancel

ALl Copy projects into workspace, #RJq &

WWW.Cypress.com
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18. fEFEF H Pk #Epr A U H

-
B | Import

Import Projects
Select a directory to search for existing Eclipse projects.

@) Select root directory:  C\Program Files (x86)\Cypress\EZ-USE FX3 SDI

(71 Select archive file:

Projects:

Il

Browse...

Browse...

BulkLoopManualRvds (C:\Program Files (x86)\Cypress\EZ-USE =
BulklpAuteCpp (C\Program Files 86\ Cypress\EZ-USE FX3 S|E|
cyulpp (CA\Program Files (x86)\Cypress\EZ-USE FX3 SDEM. 2\
F:3BootAppGee (ChProgram Files (x86)\CypresshEZ-USE FX3 5
F:3BootAppRvds (CAProgram Files (xB6)\Cypress\EZ-USE FX3!
GpichApp (C\Program Files (x86)\ Cypress\EZ-USE FX3 50K .20
GpicComplexfpp (C\Program Files (x86)\Cypress\EZ-USE FX3
SlaveFifohAsync (Ch\Program Files (x86]% Cypress\EZ-USE FX3 5C _

IFEEEEEEE

L] [ k

1|
‘ [V]iJopy projects into workspace

Working sets

[] Add project to working sets

Select All

Deselect All

4l

Refresh

Select...

@ ot ) (] |

Cancel

g. FTHBEREIS S AR TEX AN, 3 HAE “Eclipse Project Explorer” HEir. SAMTE HaiHmPE T &WH, Fit
B LAY B RO TR N R T A I H « INERsER)E, ERTCUS TR H , AT DS HOR 3 3 24T

WWW.CYpress.com YRS : 001-88777 iR A*A
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19. BRrA IUH SR TAEX N

,

File Edit Source Refactor Navigate Search Project CY Toels Bun Window Help

i |6 e ErE-E-Er -0 -0 Q- ®e - @ & [ CC] % Debug

7w 5] w¥5 (0w v

[ Project Explor &3 =8 =50 m " =0
ER-A o
[ b BquLoopManuaIR\rds |~ An _outline is not
& =% BulkLpAutoCpp available.
b 1= eyullpp

b 1= Fx3BootAppGee

I+ 125 FdBootAppRvds

= GpioApp

= GpioComplexApp
= SlaveFifofAsync

1 =% SlaveFifoAsync5Bit

I == SlaveFifoSync

b =% SlaveFifoSyncSBit

b= UartLpDmaMode

b= UartLpRegMode

b 125 USBAudioClass

b 2% USBBulkLoopAute

[ 2% USBBulkLoopAutoEnum
I+ 125 USBBulkLoophAutoMany —
2% USBBulkLoopAutoOneT:

1 2% USBBulkLoopAutoSignal

m

I =% USBBulkLoopLowlevel [E Prodtems | ) Tasks | Bl Console 52 =] Properties] 3 Debug] + B~ g~
I+ 15 USBBulkLoopManual Mo consoles to display at this time.

b 1= USBBulkLoopManualAd:
I 1= USBBulkLoopManualDC
b 125 USBBulkLoopManuallnC
i 2% USBBulkLoopManualMa
1> 2% USBBulkLoopManualOn
1 2% USBBulkLoopManualRer
= USBBquLoopMuIt\cast il

o imnn

< : I r

e 0 iterns selected Building workspace: (2%) [——]

4P I B4IT USBBuUlkLoopAuto [E 4
T E o WA R S IEAT — AN SR AS Y [ R

FX3 SDK AT #2 At i) USBBquLoopAutO R B ERARR E T BULK 3 &1 1IN BA K BULK 3 & 1 OUT. FX3 [ {4l USB EHL
Kk OUT S s A BIE G PRIR [B1 21 IN 3 5 . A I EE AT LA IN 3 %% 81 USB EHL.

1. 7E “Eclipse IDE” 1, @id i “USBBulkLoopAuto” [Elff, B Eid st e & E LN Bk, WLETIF
“UsSBBulkLoopAuto” [ . AT LA E BRI Bt T, BT DUARYE N /@ 00 B o s g, ki 5
W G0RARIEAT G T A AT RS, EBERE R 5. WAEBHTREMIE NG FHBAT, HRSHT S 2. BT
Bb g, TH#AT Eclipse TESEMEAIEE, .

2. {EXCHEFIERP, iEXE cyfxbulkloopauto.h, B RIEGREEAE N BT SCEETR 7 AR IR
CY_FX_EP_PRODUCER. CY_FX_EP_CONSUMER. CY_FX_EP_PRODUCER_SOCKET L.}
CY_FX_EP_CONSUMER_SOCKET, T LAfE cyfxbulkloopauto.h ST P 52 S s 4 = e HAR N () B3

WWW.CYypress.com R4S 5 001-88777 FRA*A 16
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3.

P 20. cyfxbulkipauto.h H i & 5 BT 58 X

@ cyfxbulklpdscr.c W

A% Endpoint and socket definitions for the bulkloop application #/

/% To change the producer and consumer EP enter the appropriate EP nuwbers for the #defines.
* In the case of IN endpoints enter EP number along with the direction bitc.
* For eg. EP 6 IN endpoint is 0OxS6
* and EP & OUT endpoint is Ox06.
* To change sockets mention the appropriste socket nuwber in the #defines. /7

f% Note: For USE 2.0 the endpoints and corresponding sSockets are one-to-ons mapped
i.e. EP 1 iz mapped to UIE socket 1 and EP 2 to socket 2 =0 on *F

#define CY FX EP PRODUCER Ox01 /% EF 1 OUT #/
#define CY FX EP CONSUMER Ox81 {7 EP 1 IN =/
#define CY FX EP PRODUCER SOCKET CY U3F_UIE SOCKET FPROD 1 /% Socker 1 is producer +/
fdefine CY FX EP CONSUMER SOCKET CY U3P_UIE SOCKET CONS 1 /+ Socket 1| iz consuwer #/

{EH BB IRST, s s LSS BTN EPL #idCh EP2, WK 21 Fia. Wik, EBMJErESF, EP2
IN ¥ BULK IN, T EP2 OUT & BULK OUT.

ER: fEUSBH, —MiaURild —NMFT (B8 M 7ENAR (LRRTA, 0 Rt 5 HAb 7 M AE vk
(H2[6:0D D RKFRIRE. —AFX3 “EH:5” fE USB A ST — N sl . USB - B H R H AL IR (i
GPIF Il (% 2 CPU) MEEFMER, HTHIR L.

21 i g S AR E R T HE S (N EPL 808 EP2)

@ cyfxbulklpauto.c ; iiﬁh hii iih ﬁ i @ cyFxbulklpdscr.c ]

4.

/7 Endpoint and socket definitions for the bulkloop application */

/% To change the producer and consumer EF enter the appropriate EP numbers for the #defines.
¥ In the case of IN endpoints enter EP nuwber along with the direction hit.
* For eg. EP & IN endpoint is OxS6
w and EP & OOT endpoint is 0Ox06.
* To change sockets mention the sppropriste socket nuwber in the #defines. *f

J* MNote: For U3EB 2.0 the endpoints and corresponding sockets are one-to-one mapped
i.e. EF 1 iz mapped to UIE socket 1 and EF 2 to socket 2 3o on */

hdefine CY FX EF PRODUCER Ox02 /% EP 2 OUT #/
tdefine CY FX EP CONSUMER Oxs2 /7 EP 2 IN */
#define CY FX_EP_PRODUCER_SOCKET CY_U3P_UIB_SOCKET PROD 2 /% Socket 2 is producer /
hdefine CY FX EP COMSUMER SOCKET CY USP UIB SOCKET CONS 2 /% Socket 2 is consumer /

HIRAEESUE B cyfxbulklpauto.h 3CfF (File >Save) . Eclipse %ii%id #E A4 [ S AR A7 5 2 85 80 SCA4F . B TE Project
Explorer J#%: B I T USBBulkLoopAuto il B, #RJ5#Kiki%&#¢ Project > Build Project, sEBLIH MI4m 3.

e, 7EA] LLESw 1% 70 H A% #% Build Configurations 3. 7E Project Explorer iR+, A AdiiiH &7k AREHRIRE
# Build Configurations > Set Active >Debug/Release (i§Z ILI4 22) .

WWW.CYpress.com YRS 001-88777 iR A*A 17


http://www.cypress.com/

EZ-USB® FX3™ A\ []

I 22. & Eclipse IDE Hi% 4% Build Configuration It

#- 1= LartpLimatdiocs b——w+cine CY FX BULKLP DMA TX SIZE
@ LS UartipReq  MNew * line CY FX BULELP THREAD STACK
& &S USBALdic  Go Into ine CY FX BULKLP_THREAD FRIORITY
-1 Open in MNew Window hdpoint and socket definitions for
-4 Binarie,
o) Iﬂ!: IﬂClUdE =] CODV Ct[’|+C 0 change the producer and consumer
o EDebug “He| e n the case of IN endpoints enter EF
i ] or eg. EP 6 IN endpoint is Ox88
@[3 cyfx_gi ¥ Delete Delete and EP & OUT endpoint is Ox0O6.
] cyfxbul - oM Contesd 't ! hiftH : o change sockets wention the approp
- [ »
5 BCVbeUl _Source ote: For USE 2.0 the endpoints and
@-[d CVbeur i.e. EP 1 iz wapped to UIE soc
® ld cyfxbie  Remame... F2
[& makefi ine CY FX EP PRODUCER
= =g [mport... ine CY FZ EP COMNSUMER
El readme = = i o
Ay
&2 USBBUIKL( & Bport... ine CY _FX EP_PRODUCER SOCKET
B & USBBUKL  Build Project ine CY FX EP COMSUMER SOCKET
i %
If: %nggu:tf Clean prOJeCt tern defir_lit,ions for the USB-Descr
H-l= UL 29 Refresh F5 rn const uintg t CyFxUSB2Z0DeviceDsac
w1 LJSBBUlkL Close Project rn const uints t CyFxU3IE30Devicelsc
528 ) rn const uint,El_t CyFxU3EDewvicemall
:J ;nggi:tf C|OS€ Unrelated pl’O]eCtS rn const uintd © CyFrRUSEFSConfighsc
=] { . P . R ... %
w-l LUSBBUIkL:
& S LSBRUkL:  Make Targets »| Manage... 2 Release
5 FEFESTE TN LN
I:J ID: USBBUIkL:  Index ’_ Build All {USENanufacture
i Z nggu:t::i Convert To... Clean All PR ERENEREsEn
E3} kL ;i
| Run As » Build Selected. .. "
P N ] = WL PT. h
HER: Release (KAi) BT HE M5 4% /T Debug
GO BT RN BRI B SR 6 & T e —— el
WS, AT ITAG 317K, ile  Program 5
o = o [
# USBBulkLoopAuto B MR FX3 RAM A p———
Wit 4 “Cypress Control Center” (3833 #4241
i) A WAL R 7 \ > NI
‘L‘) El’]E\“Aﬁ%H@E%Dﬁ%@LEXS /. Control Center v {E 3. TARINE FX3 RAM IR, i8Rk ik
N FX3 SDK 4L 7y 222 o Program > FX3 >RAM.

1. @il Start 32H, #7FF Cypress Control Center N o
KKk Start > All Programs >Cypress > Cypress
USBSuite > Control Center.

2. fHHEMHNHI USB 3.0 £4k45, il SuperSpeed 5k
Hi-Speed USB i I R AR5 HUIAHZE . QiR A& Sl
CEZHETEMFREMIKIIHA, M USB Control

I~ USE Control Centel

I2C E2PROM

Center ¥4 &8 “Cypress USB Bootloader” , SPIFLASH rf-;
KAWACIERE. HE, WREKE—% “no drive Pi
found CGRIEFIKSFEF) ~ HIEE, ES I B K g:
2% Windows IRFNFEF o M

WWW.CYpress.com YRS : 001-88777 iR A*A 18
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4. SHEIFEINED] FX3 I E SR 1%
Eclipse 7£4 Bl 2 (14 5 A2 B b AR B
USBBulkLoopAuto.img 3. TEERA TAEX S, %3
GRIIDAREE
C:\Users\antioch\Work\USBBulkLoopAuto\
Debug. ¥ )G i Open &4, B Wi 4
PR

USB Control Center T #:#i11 FX3 83)/5, Windows ¥
MFN 4N “Cypress USB BulkLoopExample” )35 USB %
o IXMHIE FX3 ME B ERIE. FX3 BAIEN
Bootloader {1 #17E Windows 1, (EIn#EHAE )G, SE
[@ USB WiTT, RJE1ENH FEARDE HTRE (BULK
B HFTERES USB. JE&, FX3 “Cypress USB
Bootloader” %%, JfH7E Control Center 3¢¥ 4 17—/
B USB 4%, RN “Cypress USB
BulkloopExample” . FX3 LAFTHILRIE 1D/~ ID (4351
4 0x04B4 1 0x00F0) M2,

ER: YEFETHHNWH, E4H RESET IR E L
FX3, f#Hi% A% Bootloader 1.

AT BULK {54

5. J&JF “Cypress USB Bulkloop Example” % H F T
T2 H. MRERRE 1 305 6 BN HBEIFRIFT
FfE, a4 %EF BULK EP2 OUT 1 BULK EP 2
IN HEERZO O AHKRB O Tl (K23) .

VER: WUREEA M E AT 20K, 7E Control Center
rh 2 EoRERIAG “BULK out endpoint (0x01)” I
“BULK in endpoint (0x81)” .

6. ZEHAT— BULK OUT f&%u, 4 ity Data Transfers
IR, AREIEEAMBERANE BULK out endpoint
(0x02)Ti, [A] Bytes to Transfer BN EEALHT
FAHE,; 17 Data to send (Hex) B\ & EAL 4
##% . Control Center ¥ H sh 7+ 7@kl 75t 2 ()4
A%, fidy Transfer Data-OUT. Kl 23 &~ T4 5
A LS BULK OUT 3 25 (0x02) F e B .

& 23. BULK OUT &%

File  Program  Help x
B (=] [T %, cE [ URB Stat Abort Pipe Reset Pipe X % L ﬁg
il = Cypress USE BulkdoopExample Descriptor Info | Data Transfers | Device Class Selectiun|
-- BOS
=k Cpnfigumtinn 1 Text to send Data to send (Hex)
- Control endpoint {(<00) i1 0102 03 04 05
e Ir!terface 0 ) Bytes to Transfer
= Atemate Setting 0 ] PkiMod
- Bulk out endpoirt (<02) -
- Bulkc in endpoint (32) | Transfer Data-OUT | | Transfer FileOUT |
BULE OUT transfer -
0000 01 02 03 04 05
BULE OUT transfer completed

7. BULK Loop F2& /714 FI A 4 5 1 IN I & [ 3% 58 i OUT s s 2R BT AT 38 . ZE3AT BULK IN A%, E B4 0 BE A 1)
BULK in endpoint (0x82). [ Bytes to Transfer FBt Wi fi &M I 7178 & . £iidi Transfer Data-IN. & 24 B/R T

7E IN Jiit i (0x82) L FRULEIAHIF Y 5 AS571

& 24. BULK IN {&4;

WWW.Cypress.com
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- USB Control Center =E e x )

File  Program  Help

& = [T 2, @8 [ URB Stat Abort Pipe ResetPipe X & (B 7
=8 Cj_.rpress IUSE Bulkloop Example Descriptor Info | Data Transfers | Device Class Selection |
- BOS
=) Corfiguration 1 Text to send Data to send (Hex)
- Control endpoirt {(<00)
£l Interface 0
: to Transfi
=~ Altemate Setting 0 oo 7 ekt
- Bull out endpoirt (3x02) ° >
Bk in endpoint (x32) | Transfer DataIN_ | | Transfer FieN |
BULE OUT transfer -

0000 01 0z 03 04 05
BULE OUT transfer completed

BULE IN transfer
0000 01 0z 03 04 05
BULE IN transfer completed

WWW.CYypress.com R4S 5 001-88777 FRA*A 20
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FRIE

HATH P B 20 FX3 & 3T T HANERIE, A% SuperSpeed Explorer £ (CYUSB3KIT-003) #1 FX3 SDK &1
HERTE Y. ¢ FX3 DVK (CYSUB3KIT-001) FfE R, HS L% C.3. FX3 DVK [ JTAG il % .

SuperSpeed Explorer 4/

FEWH T SuperSpeed Explorer ZHEE T 187 BT E. PCB 244 T FX3 ik i e R dud, LU ATECE /O Mk .
B B O, TS AMEERE. SuperSpeed Explorer B FE USB HENF 1°C JH 3. ZFFRIRIEHE —A 8 Mbit )
°C EEPROM, Jil FAERHFIFIFIIM 1°C EEPROM JEhityfif. SDK HLBLITEM £l R bIT H (& T FIFE, 0 1
DVK JT KB miRiX 5 % . SR 45k 2235 SuperSpeed Explorer £44, B A SREUE .

PIAMRE E M (T FX3 DVK HRIRSM 40502 USB 3.0 ML GEH A PC) LUK S GPIF Il 32 FIAE /M 3 %
(i B L 238 FPGA) . 2% SuperSpeed Explorer £ VE4IE R, WS HE(T 18/ . Kl 25 /8 T SuperSpeed
Explorer £ {4 HL % AR 1 8 f X 35k

& 25. FX3 DVK HLE R

USB 3.0 Connector

Power LED (LEDT) VIO1-3 Jumper (J2)
VBUS Jumper (J3)

PMODE Jumper (J4)

Reset Switch

FX3 GPIF Il /
(g)lsISOGI—TzIa';(lile/r GPIO Header
Push Button FX3 Device

USB-Serial Integrated
Blue LED (LED2) Debugger (CY7C65215)
SRAM

USB 2.0 Enable Jumper (J5)
Debugger Port

2 BoR T DVK IFARAR L B2 2 A E A TR RN B B O
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7 2. SuperSpeed Explorer Z {4 B BRAR [k 28 2%

Bhek % BRRBRE TRk

J2 fH% e I VIOL. VIO2 A1 VOIS (I E# ¥ B N 3.3V, HILACERAMEE 3.3 V 42 O IR = SRAM.

J3 o FFRARH USB 3.0 VBUS i, 4 T IF AR (10 15 % TAE, 5% as.

Ja FFi% W EEPROM LA7fiE— NG ARG 5e15, 4 i M 12C EEPROM JE3l. 0, &R B %] USB J3
.
ER: BIMNEDL N, EEPROM 14 H 4 LED INXRThAER USBBuUlkSourceSink [E 4 .

J5 JF % U B4 SRAM,
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UTP_D+ USB 2.0 D+ B
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- AT USB 2.0 (D. D-) - DU/ T v i
- N4 B AT VBUS #1 GND -W/ANFF USB 2.0 (D. D-)
- ZA AT VBUS F1 GND
RRBAEAL ML BEEEEFEHLTML HETEZENI
BRI S @M
IO BITE Fri&ks& H¥Ea R R B &
BHEHIERE AR AL 2 A B R
FR YR [EEL S DU A =
- &3 -VEE) (UD)
- ik -INE. YU (UD)
- HE. KE (U2)
- k. RE (U3
pugs-yeids:] RIhFEEE A : 100 mA {RIhFE R %: 150 mA
FIDIFE B A 500 mA FIINRE B4 900 mA
Uity RS ity VRS A U S A i Dﬁ%#ﬁi)@i@%%#, FER i TR A e e oA IR
LA R DR AR D e fee | S MR R ERREE.
RO R KK 5% BT HAHAE
SEBR b 3 KK 26 AWG K4 Z%
e i Y VORPEIRAE SRR, L. LBl S EF USB 2.0 YA S 42t Jf BA i sl e

WWW.Cypress.com

AT . 001-88777 hAS*A

30



http://www.cypress.com/

EZ-USB® FX3™ A\ []

B.1. f£ Windows %% FX3 DVK IahfEF
WEAE Windows 5Kl E A 2235 FX3 DVK &1, A%k DVK St S HUAER, ELE 8 FHfEE.

K] 34. 2235 IR AN FE I H I Windows 13 B
[ Driver Software Installati

Device driver software was not successfully installed

Please consult with your device manufacturer for assistance getting this device installed.

WestBridge xl\lo driver found

What can I do if my device did not install properly?

KMME BHEFE S HE] Windows B & FHA . ESLLZIRIE, W5 Windows & 19 # Start #48, SREAEAEE AT
Computer T, #RJ5 i Properties SRITIFREME L. S5, TELA LS Device Manager I,

35. Windows % 4% Pl 8%

File Action Niew Help

s | T E HE & B &S

4.2 Lenovoi?
> M Computer

b g Disk drives

. B, Display adapters

> -y DVD/CD-ROM drives

5% Human Interface Devices
Ly IDE ATA/ATAPI controllers
¥ Junge

-E! Mice and other pointing devices
EJ Monitors

¥ Network adapters

-l Other devices

>
>
>
s
-
5
-
o

% Ports (COM & LPT)
n Processors
-y Sound, video and game controllers

b 78 System devices
> - i Universal Serial Bus controllers

Fiti WestBridge 31 Browse my computer for driver software 3. 7 64 fif Windows 7 HiJixi b, iZIKshIEF AL E 2
C:\Program Files (x86)\Cypress\EZ-USB FX3 SDK\1.2\driver\win7\x64. % SDK A4t T 1.2,

WA E PR EMIF WestBridge A 3% SDK HR iR FE i i USB Bootloader (TiismA M) .
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| 36. WXEHTE P 2% f5 i USB BootLoader 75 % £ & #1881 2R

=4 Device Manager =l

File
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Action View Help
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|» -/l Systemn devices

a- ﬂ Universal Serial Bus controllers

Cypress USB BootLoader |

Generic USE Hub

Generic USB Hub

Generic USE Hub

Genesys Logic USE 2.0 Card Reader
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